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1. UVOD 

U ovom završnom radu cilj je usporediti visine DMR i SRTM snimki na području NP Paklenice. 

Nakon uvoda bit će opis metodologije gdje se opisuje GIS softver i njegove komponente: 

hardver, softver, podaci i ljudski resursi. Uz to se opisuju prostorni vektorski i rasterski podaci. 

Potom su definirani tipovi koordinatnih sustava WGS84 i HTRS96 koji se koriste u radu, 

prostorna analiza s objašnjenom prostornom interpolacijom DMR snimki. 

U obradi podataka redom su navedeni koraci koji se koriste za usporedbu snimki. Prvo se 

postavljaju i definiraju DMR i SRTM snimke i učitava se OSM karta u QGIS. Zatim će se 

rasteri uređivati uključujući i mijenjanje njihovih koordinatnih sustava. Izračunom razlika 

SRTM i DMR snimki će se još preciznije urediti rasteri i to u granicama NP Paklenice koji su 

stilizirani u različite boje za jednostavnije uočavanje razlika u visinama. 

Na samom kraju obrade podataka dobivena snimka razlike će se prokomentirati u zaključku uz 

detaljniji opis obrade podataka. 
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2.  OPIS METODOLOGIJE 

  2.1. GIS (Geografski Informacijski Sustav) je sustav koji koristi geoprostorne podatke 

(prostorne podatke)  za njihovo stvaranje, upravljanje, analiziranje i mapiranje. Rad GIS-a 

sastoji se od nekoliko komponenti: hardver, softver, podaci i ljudski resursi.  

Hardver je komponenta koja koristi sustav GIS za prikupljanje i analiziranje podataka koji 

pokreće GIS softver.  

Softver stvara, uređuje i analizira prostorne podatke. Postoje različite vrste softvera koje se 

mogu proširiti za širu uporabu programskog paketa te mogu biti komercijalni softveri i softveri 

otvorenog koda ( u našem slučaju QGIS).  

Prostorni podaci su baza svakog GIS-a. Postoje dvije vrste prostornih podataka: vektorski i 

rasterski podaci. 

Vektorski podaci sastoje se od objekta definiranim koordinatama (x,y) gdje se koriste kao točke, 

linije i poligoni, a rasterski podaci su podaci kojima je osnovni element piksel jer se koristi 

mreža polja podijeljena u retke i stupce (Slika2-1). Prikazuju se kao satelitske snimke, digitalni 

modeli visina, digitalni ortofoto, digitalni rasterski formati i grafičke datoteke (zemljovid, 

fotografije, slike). 

 

Slika 2-1. Prikaz vektorskih i prostornih podataka te podataka u stvarnom prostoru   (Medium, 2020.) 

 

Uz prostorne podatke postoje i atributni podaci. Oni nisu geometrijski, kao vektorski i rasterski 

podaci, nego su objekti opisani informacijama. Svaki atribut može imati određeni tip podataka: 
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tekstualna vrijednost, numerička vrijednost ili datum i vrijeme. Povezanost atributnih i 

prostornih podataka je kroz jednake vrijednosti pronađene u skupu prostornih podataka i 

atributnih podataka. Svaki podatak u GIS-u sadrži geografsku lokaciju i atribute koji ga opisuju. 

Kod ljudskih resursa važno je obrazovanje i umrežavanje ljudi za razvoj GIS stručnjaka u 

različitim poljima rada: geodezija, geologija, hidrogeologija, promet, poljoprivreda itd. 

(Osnove GIS-,2015; Dempsey,2021) 

 

2.2.  GIS KOORDINATNI SUSTAV 

Koordinatnim sustavom u GIS-u saznaje se gdje se što nalazi i mora biti definiran geodetskim 

datumom i kartografskom projekcijom. Geodetski datum definira položaj zemljinog tijela u 

prostoru, tj. veličinu i oblik Zemljinog elipsoida, koordinatni sustav i orijentaciju u odnosu na 

Zemlju (geoid). Geoid je model Zemljine površine.  

Kod geodetskog datuma, elipsoid se dijeli  s obzirom na veličinu opisane površine na lokalni i 

globalni elipsoid. Površina neke regije ili države je lokalni elipsoid, dok je Zemljina površina u 

cjelini regionalni elipsoid (Slika 2-2). 

 

Slika 2-2. Prikaz lokalnog (crvena boja) i globalnog elipsoida (zelena    boja) s obzirom na geoid 

(plava boja). (Osnove GIS-a, 2015) 

 

Transformacijom koordinata elipsoida (zakrivljene Zemljine površine) na ravninske koordinate 

(ravna ploha) dobije se projekcijom. Transformacija je vizualno pojednostavljena pretvorbom 

iz 3D sustava u 2D sustav. Primjer lokalnog elipsoida je Besselov elipsoid, a primjer najčešće 

korištenog globalnog elipsoida je WGS84. 

 

WGS84 koristi se kao referentni koordinatni sustav za GPS na globalnoj razini. Razvijen je 

1980-ih u SAD-u. Do 2004. godine u Hrvatskoj je bio zastupljen lokalni BESSEL 1841 elipsoid 

no od 2010. godine je uveden GRS80 referentni elipsoid. U Hrvatskoj se koriste projekcije 

Gauss-Krügerova projekcija i HTRS96/TM. 
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Gauss-Krügerova projekcija je cilindrična projekcija koja sadržava dva koordinatna sustava (5 

i 6) s obzirom na početni Greenwichov meridijan. Svaki koordinatni sustav, tj. zona ima drugi 

dodirni meridijan jer je u svakoj zoni projekcija meridijana pomoću x-osi i projekcija ekvatora 

pomoću y-osi. Širina svake zone je 3°. 5. zona ima središnji 15° meridijan , a 6. zona ima 18° 

meridijan. A na oba meridijana preslikava se teritorij sa elipsoida. 

 

HTRS96 (Hrvatski terestrički referentni sustav za epohu 1995.55) projekcija koristi se od 2004. 

godine sa središnjim meridijanom 16°30' (Slika 2-3). U odnosu na  Gauss-Krügerovu projekciju 

koristi GRS80 elipsoid. Osi projekcije su E (istočno) i N (sjeverno). E je projekcija ekvatora, a 

N srednjeg meridijana. Svim se ordinatama dodaje E=500 000 metara, tj. projekciji središnjeg 

meridijana da ne bi došlo do negativnih koordinata. (Šurina, 2022.)  

 

Slika 2-3.Prikaz HTRS96 i njezina podjela na detaljne listove (DGU, 2011) 
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2.3. PROSTORNA ANALIZA 

Prostorna analiza je slaganje slojeva koji imaju različite podatke te se stoga usporedno slažu i 

stvaraju novi slojevi gdje dolazi do promjene atributnih i geometrijskih podataka.  

(Osnove GIS-a, 2015.) Prostorna interpolacija je postupak gdje se točke s nepoznatim 

vrijednostima procjenjuju pomoću točaka s poznatim vrijednostima, a rezultat interpolacije je 

rasterski sloj. (QGIS-c, 2022.)  

U radu se koristi sloj DMR-a (Digitalni model reljefa) sastavljen od horizontalnih (površinskih) 

i vertikalnih (visinskih) sustava sa mnogim pogreškama. Nastajanje pogrešaka pojavljuje se u 

prikupljanju podataka, metodologiji obradi podataka, razmaka između rešetaka, nepoznatim 

kombinacijama pogrešaka i dr. Često se DMR-ovi koriste bez procjene njihove točnosti pa se 

zato koriste referentni podaci. 

Četiri metode interpolacije su :  

• Najbliži susjed koji bira i preuzima vrijednost najbližeg piksela, a ne susjedne piksele.  

• Prirodni susjed izračunava prirodne susjede točke interesa. Prirodni susjedi su točke 

povezane sa susjednim poligonima koji se dobivaju na temelju različitih podskupova 

ravnine. 

• Bilinearna interpolacija (interpolacija prvog reda)  produkt je dviju linearnih funkcija i 

određuje vrijednost nepoznate točke na temelju težinskog prosjeka. 

• Bikubična interpolacija za razliku od bilinearne interpolacije proizvodi glađe rubove i 

sofisticiranija je. Najčešće je korištena u uređivanju slika, upravljačkim programima 

pisača i digitalnim fotoaparatima. (Pokupić, 2018) 

Visinski sustavi dijele se u tri  osnovne skupine predstavljanja površina u digitalnom sustavu 

(Slika 2-4):  

1. Pravilna mreža (rešetka ili matrica) pikselima pojednostavljuje prikaz reljefa,  a 

određena je prostornom rezolucijom i veličinom rastera ( broj redaka i stupaca). Zbog 

svoje jednostavnosti najviše se primjenjuje. 

2. TIN (triangulacijska nepravilna mreža) točkama, linijama i poligonima pojednostavljuje 

prikaz reljefa. Definiran je čvorovima, bridovima, trokutima i topologijom. Susjedne 

točke spajaju se u trokutaste ravnine koje čine mrežu korištenjem Delaunayeve 

triangulacije. To je metoda kojom se koristi Delaunayev trokut kroz kojeg, na svakom 

vrhu, prolaze kružnice, a da pritom ne uključuje niti jednu drugu točku.  
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3. Izohipse pojednostavljuju izradu modela određenog kompleksnog hidrološkog procesa 

te se zato primjenjuju u hidrologiji. Izohipse kao visinski podaci ne predstavljaju DMR 

jer on podrazumijeva kontinuirane podatke na svakoj x,y lokaciji. (Šiljar, 2013) 

 

Slika 2-4. Skupine koje predstavljaju površinu u digitalnom sustavu (Šiljar, 2013) 

  

 

2.4. QGIS 

QGIS je Geografski informacijski sustav otvorenog koda koji ima besplatnu upotrebu na Linux, 

Unix, Mac OSX, Windows i Android platformama i podržava vektorske i rasterske podatke te  

baze podataka. QGIS obuhvaća mnogo GIS funkcija sa osnovnim značajkama i mogućom 

nadogradnjom.  (QGIS-a, 2022) 

Postoji šest općih kategorija značajki i dodataka: 

1. Pregled podataka je mogućnost pregleda rasterskih i vektorskih podataka (2D ili 3D) u 

različitim projekcijama i formama. Pri tome ne dolazi do pretvorbe u interni ili 

zajednički format. 

2. Pretraga podataka i sastavljanje karte je moguće pomoću GUI-a. GUI (Graphical User 

Interface)  je grafičko sučelje koje ima pet komponenti: Traka izbornika, alatne trake, 

paneli, prikaz karte i statusna traka. U komponentama nalaze se korisni alati GUI-a, a 

neki od njih su: QGIS preglednik,  pregledna ploča, 2D i 3D prikaz karte, upravitelj 

baze podataka, izgled ispisa, izvješće, alati za označavanje, uređivanje pregled, 

pretraživanje atributa itd.  

3. Stvaranje, uređivanje, upravljanje i izvoz podataka u obliku rasterskih i vektorskih 

slojeva u nekoliko formata. QGIS nudi: upotrebu alata za vektorsku digitalizaciju, 

mogućnost stvaranja i uređivanja više formata datoteka, georeferencer dodatak za 

geokodiranje slika, podrška za vizualizaciju i uređivanje OpenStreetMap podataka  itd. 

4. Analiziranje podataka : Analiza prostornih podataka izvršava se u bazama podataka o 

prostoru i drugim formatima. Ponuđuje se vektorska analiza, analiza rastera, 
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uzorkovanje (eng. Sampling), geoprocesiranje, geometrija i alati za upravljanje bazom 

podataka. 

5. Objava karti na internetu: QGIS se može koristiti kao WMS, WMTS, WMS-C, WFS, 

OAPIF I WFS-T klijent. Instalacijom UMN MapServer-a ili GeoServer-a s 

webserverom je moguće objaviti podatke na internetu. 

6. Proširivanje QGIS funkcionalnosti kroz dodatke, tj. moguća je prilagodba QGIS-a za 

željenim dodacima i bibliotekama za izradu dodataka. Moguće je stvaranje novih 

aplikacija s C++ ili Python programima. (QGIS-b, 2022) 

 

3. OBRADA PODATAKA 

  U obradi podataka su opisani koraci usporedbe digitalnog modela terena i SRTM satelitske 

snimke na području NP Paklenica. 

3.1. Učitavanje podataka 

 Na stranici USGS.gov može se besplatno preuzeti  SRTM snimka 30 metarske rezolucije (Slika 

3-1). Snimka SRTM-a mjeri visinu Zemlje radarskom antenom gdje je dio antene smješten na 

području za teret, a drugi dio na kraju jarbola od 60 metara gdje se pomoću interferometrijskog 

radara sa sintetičkom aperturom (inSAR) generira digitalni model visine. Radarski sustav 

sastoji se od C-pojasnih i X-pojasnih radara sa sintetičkom aperturom (SIR-C i SIR-X). C-

pojasni radar ne može „vidjeti“ gustu vegetaciju na površini Zemlje, jer se teško probija kroz 

krošnju. Zato se u područjima s velikom šumom SRTM bilježi samo vrh krošnje. (SRTM 

Wikipedia, 2021; GISGeography,2022) 
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Slika 3-1 SRTM snimka 

 

DMR snimka dobivena je iz HOK slojnica(Slika 3-2). Ona je 3D model zemljine površine s 

određenim točkama i geometrijskim elementima (prijelomnica, linija oblika i površina 

isključenja). Izrađena je fotogravimetrijskim kartiranjem iz aerofotogrametrijskog snimanja 

pomoću digitalnih fotogrametrijskih stanica. 

Koristi se u interpretaciji oblika zemljine površine s raznolikom primjenom: projektiranje 

objekata i prometnica, utvrđivanje dosega optičke vidljivosti i radio valova, projektiranje 

hidrotehničkih zahvata, izrada karata i različitih visinskih i perspektivnih prikaza ta u izradi 

digitalnog ortofota. (DGU,2022; ZZF, 2022) 

 

Slika 3-2 DMR snimke u WGS84 (lijevo) i HTRS96 (desno) koordinatnom sustavu 
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SRTM snimke su u izvornom WGS84 koordinatnom sustavu pod nazivom SRTM_USGS, a 

DMR snimke u WGS84 i HTRS96 koordinatnom sustavu pod nazivom dmr_paklenica_wgs84 

i dmr_paklenica_htrs96. Učitavanje snimki u QGIS je na izborniku Layer > Add Layer > Add 

Raster Layer, a za lakšu orijentaciju učitava se besplatna OSM Karta (Open Street Map) na 

izborniku Web >QuickMapServices > OSM > OSM Standard (Slika 3-3). 

 

Slika 3-3 OSM karta 

 

OSM karta je sačinjena od oznaka koje pridružuju  njegove osnovne strukture podataka 

(čvorovi, putevi i odnosi) i fizičke značajke na terenu (npr. ceste ili zgrade). Ona omogućuje da 

svaka oznaka opisuje geografski atribut značajke (prikaz čvora, puta ili odnosa). (OSM Wiki, 

2022) 

 

3.2 Uređivanje rastera i promjena koordinatnog sustava 

Preuzeta SRTM snimka sadrži veliki obujam područja koji nije potreban u istraživanju pa se 

uklanja na izborniku Raster > Extraction > Clip raster by extent gdje se otvaranjem prozora 

pod Input layer bira raster SRTM_USGS, a u Clipping extent raster dmr_paklenica_wgs84 

(Slika 3-4). Pošto su oba rastera u WGS84 koordinatnom sustavu kao rezultat će ishoditi 

pravokutni raster srtm_wgs84 (Slika 3-5) u istom koordinatnom sustavu te manjeg obujma 

površine. 
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Slika 3-4 Biranje rastera dmr_paklenica_wgs84 pod Clipping extent. 

 

 

Slika 3-5 Raster srtm_wgs84 

 

Premda je potreban raster u HTRS96 koordinatnom sustavu na raster srtm_wgs84, koji je u 

WGS84 koordinatnom, na izborniku se odabere Export > Save As gdje se otvori prozor Save 

Raster Layer As... Nužno je odabrati datoteku gdje će se raster spremiti i imenovati 

(srtm_htrs96) pod File name. Zadnje se odabere koordinatni sustav kod CRS u EPSG:3765- 

HTRS96/ Croatia TM (Slika 3-6). Kao rezultat dobit će se srtm_wgS84 i srtm_htrS96 rasteri u 

GeoTIFF formatu (Slika 3-7). 
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Slika 3-6 Prikaz prozora gdje se sprema srtm_wgs84 u HRTS96 koordinatni sustav 

 

 

Slika 3-7 Raster srtm_htrs95 

 

TIFF (Tag File Format) je format slikovne datoteke koji se koristi za pohranu rasterskih 

grafičkih slika. Popularan je u primjeni zbog svoje fleksibilnosti, visoke kvalitete i univerzalne 

kompatibilnosti. (TIFF Wikipedia, 2022.; Adobe, 2022) 
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3.3  Izračun razlika visina između SRTM i DMR 

Razlike se dobivaju usporedbom, tj. oduzimanjem srtm_hrts95 i dmr_paklenica_htrs96 snimka 

na  izborniku Raster > Raster Calculator gdje se otvori prozor u kojem se bira koordinatni 

sustav i datoteka spremanja novo nastalog rastera razlika (Slika 3-8). 

 

Slika 3-8 Raster kalkulator 

 

3.4 Definiranje granica 

Novonastalom rasteru razlika potrebno je točnije definirati granice istraživanja što je u ovom 

slučaju granica NP Paklenice. Granice se preuzimaju online u HTRS96 koordinatnom sustavu 

u vektorskom obliku poligona. Definiranje granica je na izborniku Raster >  Extraction > Clip 

raster by mask layer gdje se otvara prozor gdje odabirom pod Parameters biramo Input layer i 

Mask layer(Slika 3-9). Pod Input layer se bira raster razlika, a pod Mask layer poligon granice 

NP Paklenica(Slika 3-10). 
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Slika 3-9 Prikaz granica NP Paklenice (ljubičasto desno) ispod kojeg je raster razlika (sivo desno) te 

odabir prozora Clip raster by mask layer… 

 

Slika 3-10 Rezanje rastera u veličinu područja granice NP Paklenica 
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3.5 Stiliziranje 

Novo dobiveni raster granica_razlike uređuje se desnim klikom miša na njega te odabirom 

Properties > Symbology(Slika 3-11). Tu mu se pridodaje boja sa definiranim visinskim 

razlikama kod svake boje. Visinski maksimum je tamno plave boje od 231 metra, a minimum 

je crvene boje od -172 metra. Većina područja obojano je narančastom i svjetlo narančastom 

bojom (Slika 3-12). 

 

Slika 3-11 Stiliziranje rastera 
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Slika 3-12 Obojani raster granica_razlike 
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4. Zaključak 

U ovom završnom radu koristio se QGIS softver zajedno sa SRTM i DMR snimkama i OSM 

kartom. Učitana SRTM snimka se smanjivala  za lakše istraživanje, a potom joj se mijenjao 

koordinatni sustav iz WGS84 u HTRS96. Nakon mijenjanja koordinatnog sustava radila se 

usporedba  između SRTM i DMR snimki, tj. razlika između  SRTM snimke od DMR snimke 

odakle se dobila snimka razlike. Za lakšu orijentaciju i usporedbu karte i snimke u softver je 

učitana OSM karta. 

 Zatim je snimka razlike oblikovana u granicame NP Paklenice i dobivena je u crno-sivoj boji 

sa vidljivim odstupanjima. Zadnje se snimka bojala u Spectral boje za lakše uočavanje najvećih 

i najmanjih razlika visinskih slojeva. Time se ustanovljuje da se na snimci najviše javljaju boje 

sa narančastom i svijetlo narančastom bojom dok su plavom i zelenom bojom označena najviša 

odstupanja do 231 metra, a crvenom bojom najniža odstupanja od -172 metra. Drugim riječima, 

veća visina razlike slojeva prikazuje postojanost velike udaljenosti koju je SRTM snimak 

snimio i DMR snimke koja mjeri površinu zemlje. Odstupanja nastaju u područjima sa gustom 

vegetacijom i urbanizacijom jer SRTM-ov signal nije u mogućnosti proći kroz šume, grmlje ili 

planinarske kuće do površine nego mu je visina mjerenja jednaka visini krošnji i krovova.  

Travnate površine imaju manja odstupanja dok područja s ogoljenim kamenjem najmanja. 

Tijekom izrade završnog rada QGIS je bio idealan odabir u primjećivanju nedostataka SRTM 

snimki.  
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